
KEY Description of task

Summary of recommended procedure

Exercise reference(s)

3-D effect 9-11
Select the object and click the 3-D Style button  
on the Drawing toolbar. Choose a style.

3-D reference with a formula 10-9
Click the cell and press =. Click the worksheet 
tab and the fi rst cell for the calculation. Key 
the operator. Click the worksheet tab and cell. 
Press e .

3-D reference with a function 10-13
Click the cell and click the Insert Function 
button . Choose the function. Click the work-
sheet tab and the cell for the fi rst argument. 
Click the next argument box, click the work-
sheet tab, and click the cell. Click OK.

Absolute reference 5-17
Click anywhere in the cell address in the for-
mula bar. Press ¢ .

Align Right 4-16
Select the cell or the range. Click the Align 
Right button .

AND function 6-3
Click the cell for Logical1 and key the rest of 
the expression. Repeat these steps for each con-
dition or tests. Click OK.

Arrange windows 10-18
Open the workbooks. Choose Window, Arrange. 
Choose the tiling option. Click OK.

AutoCalculate 2-18
Right-click the status bar and choose the oper-
ation. Then select the cells to be checked.

Autofi lter, create 10-22
Click in the named range and choose Data, 
Filter, AutoFilter. Click the drop-down button 
and choose the item to be matched.

AutoFormat 3-16
Click a cell in the range. Choose Format, Auto-
Format. Choose the desired style and click OK.

Automatic chart 8-8
Select the range of values and labels in the 
worksheet. Press – .

AutoSum 2-17
Click the cell for the sum. Click the AutoSum 
button .

Borders 4-23
Select the cell or range. Click the arrow next 
to the Borders button . Choose the desired 
border style.

Callout, create 9-1
Click AutoShapes and choose Callouts. Choose 
the desired shape and draw the object on the 
worksheet. Key the text. Click another cell to 
deselect the shape.

Center 4-16
Select the cell or the range. Click the Center 
button .

Center across selection 4-17
Select the range for centering. Press Ç +1 . 
Click the Alignment tab. Click the Horizontal 
arrow and choose Center Across Selection. 
Click OK.

Center page 6-11
Click the Print Preview button . Click the 
Margins tab. Choose Horizontally in the Center 
on page section. Click OK.

Chart type 8-22
Right-click the chart or an individual bar/
column. Choose Chart Type. Choose the chart 
type and sub-type. Click OK.

Chart, create 8-9
Select the range of values and labels in the 
worksheet. Click the Chart Wizard button . 
Choose the chart type and subtype. Complete 
other options for the chart. Set the location for 
the chart. Click Finish.

Chart, move 8-10
Click the chart’s background area. Point at the 
background and drag the chart on the worksheet.

3-D effect 9-11
Select the object and click the 3-D Style button  
on the Drawing toolbar. Choose a style.
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Chart, preview 8-1
Select the chart and click the Print Preview 
button  to preview the chart by itself. Deselect 
the chart and click the Print Preview button  
to preview the chart with the worksheet.

Chart, print 8-2
Select the chart and click the Print button  
to print the chart by itself. Deselect the chart 
and click the Print button  to print the chart 
with the worksheet.

Chart, size 8-10
Select the chart area. Point at a selection 
handle and drag the handle to size the chart.

Check Errors 3-3
Click the cell with the green triangle and the 
button to display the arrow. Click the arrow to 
see the error messages. Choose a suggestion or 
make your own correction.

Clear formats 6-7
Select the cell(s). Choose Clear and Formats 
from the Edit menu.

Close a workbook 1-7
Click the Close Window button .

Column width 2-6
Drag the column’s right border.

Column width, change 3-21
Click the Print Preview button . Click Margins. 
Drag a column marker to the desired width.

Comment, delete 9-22
Right-click the cell and choose Delete 
Comment.

Comment, discussion 9-25
Choose Tools, Online Collaboration. Choose Web 
Discussions. Click the Insert Discussion About 
the Workbook button . Key the comment.

Comment, insert 9-21
Right-click the cell and choose Insert Comment. 
Key the text and click another cell. Edit the 
comment by right-clicking the cell and choos-
ing Edit Comment.

Comment, print 9-22
Right-click the cell and choose Show Comment. 
Choose File, Page Setup. Click the Sheet tab. 
In the Comments list, choose As displayed on 
sheet or At end of sheet. Click OK.

Copy and paste cell contents 4-8
Select the cell or the range and press Ç +C . 
Position the pointer for the copy and 
press Ç +V .

Copy with AutoFill 3-14
Click the cell to be copied. Place the mouse 
pointer on the Fill handle and drag to reach the 
last cell for pasting the copy.

Copy worksheet 10-1
Right-click the worksheet tab. Choose Move or 
Copy. Choose (move to end) to place the new 
sheet at the end of the group. Click to place a 
checkmark for Create a copy. Click OK.

Copy, formula 2-16
Click the cell with the formula. Click the 
Copy button . Select the cell(s) the copies. 
Press e .

Current date 7-5
Click the cell and key =today(). Press e .

Custom view, create 10-31
Set the display and print options for the work-
sheet. Choose View, Custom Views. Click Add 
and key the name. Click OK.

Cut and paste cell contents 4-7
Select the cell or the range of cells and press 
Ç +X . Position the pointer at the new loca-
tion and press Ç +V .

Data point, add 8-15
Key the new label and values. Select the chart 
area. Drag with the bottom right handle of the 
data range to include the new row/column.

Data point, delete 8-17
Select the label and values in the worksheet. 
Press y .

Data series, add 8-16
Key the new label and values. Right-click the 
chart and choose Source Data. Select the new 
data range and click OK.

Data series, delete 8-17
Select the row or column heading. Press 
y . Right-click the chart and choose 
Source Data. Redefi ne the new data range and 
click OK.
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Data table 8-13
Right-click the chart area and choose Chart 
Options. Click the Data Table tab. Place a check-
mark in the Show data table box. Click OK.

Decrease decimal positions 4-27
Select the cell or the range. Click the Decrease 
Decimal button .

Delete cell 4-4
Select the cell or the range to be deleted and 
right-click. Choose Delete. Choose the appropri-
ate option for shifting the other cells. Click OK.

Delete cell contents 1-12
Click the cell to make it the active cell. 
Press y .

Delete column 4-13
Right-click the column heading(s) and choose 
Delete.

Delete row 4-12
Right-click the row heading(s) and choose 
Delete.

Delete worksheet 4-2
Right-click the worksheet tab and choose 
Delete.

Edit cell contents 1-11
Click the cell to make it the active cell. 
Press ™  to start Edit mode. Edit the informa-
tion and press e .

Exit Excel 1-17
Click the Close button .

Find and replace formats 3-10
Press Ç +H  and delete any text in the Find 
what box. Delete text in the Replace with box. 
Click Format for the Find what string. Click 
Choose Format From Cell and click a cell with 
the format to be changed. Click Format for the 
Replace with string. Click Format. Click the 
appropriate tab in the dialog box and make 
the changes for how the data should be format-
ted. Click OK. Click Find All to list the occur-
rences and then click Replace All to replace the 
format. Close the message and dialog boxes.

Find data 3-5
Press Ç +F  and key the fi nd character string 
in the Find what box. Click Find All.

Fit to page 5-22
Click the Print Preview button . Click Setup 
and the Page tab. Click the Fit to button. Set 
how many pages should print.

Font, bold or italic 2-2
Select the cell(s) to be changed. Click the Bold 
button  and/or the Italic button .

Font, change 2-2
Select the cell(s) to be changed. Click the Font 
button  and choose the font name.

Font, color 2-11
Select the cell(s). Click the arrow next to the 
Font Color button  and choose a color.

Font, size 2-2
Select the cell(s) to be changed. Click the Font 
Size drop-down arrow and choose the size.

Format multiple sheets 9-2
Group the worksheets. Apply the formats as 
usual. Ungroup the sheets.

Format, axis 8-6
Right-click a category or value and choose 
Format Axis. Click the appropriate tab and 
make the changes. Click OK.

Format, chart title 8-3
Right-click the title and choose Format Chart 
Title. Click the appropriate tab and make the 
changes. Click OK.

Format, currency 2-6
Select the cell(s). Click the Currency Style 
button .

Format, data series 8-4
Right-click a marker (row, column, line) and 
choose Format Data Series. Click the appropri-
ate tab and make the changes. Click OK.

Format, date 2-7
Select the cell(s). Press Ç +1 . Click the 
Number tab and choose the Date Category. 
Choose the desired type and click OK.

Format, legend 8-11
Right-click the legend and choose Format 
Legend. Click the appropriate tab and make 
the changes. Click OK.
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Formula, enter 2-14
Click in the cell where the formula will be 
located. Press =. Click the fi rst cell and key 
the arithmetic symbol. Click the next cell and 
the next arithmetic symbol. Press e  when 
fi nished.

Formulas, show/hide 5-22
Press Ç +~ .

Freeze/Unfreeze column or row 4-15
Click in the column or row to be locked in posi-
tion. Choose Window, Freeze or Unfreeze Panes.

Function, key in cell 5-10
Press =, then key the name of the function, 
and a left parenthesis. Choose the cell(s) for the 
argument and press e .

FV function 6-16
In the Rate box, click the cell with the interest 
rate. Key /12 if making monthly payments. 
Click the Nper box and click the cell with the 
total number of payments. Click the Pmt box 
and click the cell with the deposit amount. 
Click the Pv box and click the cell (if any) with 
the amount of money already in the account. 
Click the Type box and key 1 for deposits made 
at the beginning of the month. Click OK.

Go To a cell 1-4
Press ∞  or Ç +G . Key the cell address. 
Press e .

Go To Cell A1 1-4
Press Ç +h .

Gradient fi ll 8-20
Right-click a bar or column. Choose Format 
Data Series. Click the Patterns tab. Click Fill 
Effects. Click the Gradient tab. Choose the 
colors or a preset. Choose the shading style and 
its variant. Click OK.

Gridlines 8-13
Right-click the chart area and choose Chart 
Options. Click the Gridlines tab. Turn on the 
desired lines and click OK.

Group worksheets 10-2
Click the fi rst worksheet tab. Hold down s  
or Ç  to select multiple tabs. 

Header/footer 3-19
Click the Print Preview button . Click 
Setup. Click the Header/Footer tab. Choose a 
preset header/footer or click Custom Header or 
Custom Footer. Enter text or click a button for 
each section. Click OK. 

Header/footer, image 9-20
Click the Print Preview button . Click Setup 
and the Header/Footer tab. Choose Custom 
Header or Custom Footer. Click in the section 
and click the Insert Picture button . Find 
and select the image and click Insert. Click OK.

Hide/Unhide column or row 4-14
Right-click the column or row heading. Choose 
Hide or Unhide.

Hyperlink 7-14
Click the cell to show the link. Click the Insert 
Hyperlink button . Key the URL address or 
the pathname in the Address box. Key a label 
in the Text to display box. Click OK.

IF function 6-1
Click the cell for Logical_test and key the rest 
of the expression. Click the Value_if_true box 
and key/click the value or text to be shown. 
Click the Value_if_false box and key/click the 
value or text to be shown. Click OK.

Image fi ll 8-18
Click a bar or column. Click the Insert Clip 
Art button . Key a search word or choose a 
category and an image. Click the image in the 
task pane to place it in the worksheet. Close the 
task pane.

Increase Decimal 5-7
Select the cell or ranges to be formatted. Click 
the Increase Decimal button  to each deci-
mal position to be changed.

Indent text 4-19
Select the cell or the range and press Ç +1 . 
Click the Alignment tab. Set the Horizontal set-
ting to Left (Indents). Set the Indent to the 
number of spaces. Click OK.

Insert cell 4-3
Select the cell or the range where the new 
cell(s) should be located. Right-click and 
choose Insert. Choose the appropriate option 
for shifting the existing cells. Click OK.
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Insert column 4-13
Right-click the column heading(s) and choose 
Insert.

Insert Function 5-11
Click the Insert Function button . Select the 
category and the function name. Click OK. 
Click in the entry boxes in the Function Argu-
ments palette and choose the cell(s). Click OK.

Insert row 4-11
Right-click the row heading(s) and choose Insert.

Insert worksheet 4-1
Press s +–.

INT function 7-1
Edit the cell. Position the pointer after the 
= sign and key int(. Press u  and key the 
right parenthesis after the last digit/character. 
Press e .

Left, Align 4-16
Select the cell or the range. Click the Align Left 
button .

Line, create 9-3
Click the Arrow button  and draw the object on 
the worksheet. Click a cell to deselect the object.

Margins, change 3-21
Click the Print Preview button . Click Mar-
gins. Drag each margin marker to the desired 
position.

Margins, page 5-21
Click the Print Preview button . Click Setup 
and the Margins tab. Set the Left, Right, Top, or 
Bottom margin. Click OK.

Merge and Center 4-20
Select the range. Click the Merge and Center 
button .

Mixed reference 5-18
Click anywhere in the cell address in the for-
mula bar. Press ¢  repeatedly to show the $ 
with the appropriate part of the address.

Move worksheet 4-2
Point at the worksheet tab. Drag it to the 
desired location.

Nested function 7-10
Start the fi rst function and enter the appro-
priate arguments. For the argument that uses 
another function, click the arrow next to Func-
tion Name and choose the other function. Com-
plete the arguments for the second function. 
Click in the formula bar within the name of the 
fi rst function. Complete the fi rst function and 
click OK.

New folder 1-14
Choose File, Save As. Navigate to the appro-
priate location. Click the Create New Folder 
button . Key the folder name and click OK.

New, from template 5-1
Choose General Templates in the New Workbook 
side pane. Choose the template and click OK.

New workbook 2-1
Click the New button .

Next or previous workbook 1-3
Click the worksheet tab.

NOT function 6-5
Click the cell for Logical and key the rest of the 
expression. Click OK.

Object, change 9-8
Select the object. Choose Draw and Change 
AutoShape. Choose the new shape.

Object, color 9-5
Select the object with a dotted pattern outline. 
Click the Line Color button  to change the 
outline color. Click the Fill Color button  to 
change the background.

Object, font 9-4
Select the text in the object or select the object 
with the dotted pattern outline. Choose the font 
name and size from the Formatting toolbar.

Object, move 9-6
Select the object. Drag the object with the four-
headed arrow.

Object, size 9-6
Select the object. Drag a handle to size the 
object.

Objects, align 9-12
Select the objects to be positioned. Choose Draw, 
Align or Distribute. Choose the alignment option.
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Objects, distribute 9-12
Select the objects to be positioned. Choose 
Draw, Align or Distribute. Choose the distribu-
tion option.

Open workbook 1-8
Click the Open button . Locate the folder or 
fi le, and double-click the fi lename.

OR function 6-4
Click the cell for Logical1 and key the rest of 
the expression.  Repeat these steps for each 
condition. Click OK.

Order of precedence 5-9
Press ™  to edit the formula. Insert parenthe-
ses around calculations that should be done 
fi rst. Press e  when fi nished.

Orientation, page 5-20
Click the Print Preview button . Click Setup 
and the Page tab. Choose Landscape or Por-
trait. Click OK.

Page break, delete 6-13
Position the pointer to the right of or below the 
page break. Choose Insert, Remove Page Break.

Page break, insert 6-9
Position the pointer in the cell to the right of or 
below where the page break should be. Choose 
Insert, Page Break.

Page break, preview 6-8
Click the Print Preview button . Click Page 
Break Preview. Click OK.

Page numbers 6-12
Click the Print Preview button . Click Setup 
and the Header/Footer tab. Click Custom 
Footer. Click in the section for page numbers. 
Click the Page Number button  and/or the 
Pages button . Click OK.

Paste a link 10-30
Select the cells and click the Copy button . 
Click the cell for the location of the link. 
Choose Edit, Paste Special. Click Paste Link.

Pattern fi ll 8-21
Right-click a bar or column. Chooses Format 
Data Series. Click the Patterns tab. Click Fill 
Effects. Click the Pattern tab. Choose a tile and 
background and foreground colors. Click OK.

Percent Style 5-7
Select the cell or ranges to be formatted. Click 
the Percent Style button .

Pick from List 4-6
Right-click the cell. Choose Pick from List. 
Choose the entry.

Picture, background 9-18
Choose Format, Sheet, Background. Choose the 
image and click Insert. Remove the image by 
choosing Format, Sheet, Delete Background.

Picture, format 9-16
Right-click the picture and choose Format 
Picture. Click the appropriate tab and make 
the changes. Click OK.

Picture, from fi le 9-15
Click the Insert Picture from File button . 
Find the image and double-click it.

Picture, from Media Gallery 9-17
Click the Insert Clip Art button . Search for 
the image and click it.

PMT function 6-14
In the Rate box, click the cell with the interest 
rate. Key /12 if making monthly payments. Click 
the Nper box and click the cell with the total 
number of payments. Click the Pv box and click 
the cell with the loan amount. Click the Fv 
box and click the cell (if any) with a loan bal-
ance. Click the Type box and key 1 for payments 
made at the beginning of the month. Click OK.

Preview a workbook 1-16
Choose File, Print. Choose Entire workbook in 
the Print what group. Click Preview.

Preview a worksheet 1-15
Click the Print Preview button .

Print a workbook 1-16
Choose File, Print. Choose Entire workbook in 
the Print what group. Click OK or press e .

Print a worksheet 1-21
Click the Print button .

Print area, clear 10-28
Choose File, Print Area, Clear Print Area.

Print area, set 10-28
Select the cells. Choose File, Print Area, Set 
Print Area.
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Print gridlines 3-20
Click the Print Preview button . Click Setup. 
Click the Sheet tab. Turn on the Gridlines 
option. Click OK.

Print row and column headings 3-20
Click the Print Preview button . Click Setup. 
Click the Sheet tab. Turn on the Row and 
column headings option. Click OK.

Print selection 3-18
Select the cells to be printed. Choose File, 
Print. Choose Selection in the Print what area. 
Click OK.

PROPER function 7-13
Edit the cell. Position the pointer after the = 
sign and key proper(. Key the text if necessary 
with quotation marks. Press e .

Range, name 10-21
Select the cells to be named. Click the Name 
box and key the name. Press e .

Redo 1-13
Click the Redo button . Click the history 
arrow next to the button and highlight the 
tasks to redo more than one action.

Rename worksheet 2-12
Double-click the worksheet tab and key the new 
name. Press e .

Replace data 3-7
Press Ç +H  and key the fi nd character string 
in the Find what box. Key the replacement 
string in the Replace with box. Click Replace 
to replace each occurrence or click Replace All 
to replace all at once.

Reshape object 9-7
Place the mouse pointer on the yellow diamond 
adjustment handle. Drag the handle to reshape 
the object.

Rotate object 9-7
Place the mouse pointer over the green rotation 
handle. Drag the mouse to rotate.

Rotate text 4-21
Select the cell or the range and press Ç +1 . 
Click the Alignment tab. Set the Orientation 
graphic to the desired degree of rotation. 
Click OK.

ROUND function 7-3
Edit the cell and position the pointer after the = 
sign. Key round( and press u . Key a comma  
and key a digit for the number of decimal posi-
tions. Key ) and press e .

Row height 2-7
Drag the row’s bottom border.

Save 2-13
Click the Save button . Set the Save in folder 
and key the fi lename. Click Save.

Save As 1-14
Press ≠ . Locate the folder and key the fi le-
name. Click Save.

Scale, page 5-21
Click the Print Preview button . Click Setup 
and the Page tab. Set the Adjust to percentage 
in the Scaling section. Click OK.

Secondary axis 8-24
Right-click the column, bar, or line to be 
changed. Choose Format Data Series. Click the 
Axis tab. Place a checkmark for Secondary 
axis. Click OK.

Select cells, keyboard 2-5
Click the top-left cell in the range and press 
• . Press Arrow keys to highlight to the lower-
right cell in the range.

Select cells, mouse 2-4
Click the top-left cell in the range and drag to 
the lower-right cell in the range.

Series, day or month 3-12
Key a day or month in a cell. Place the mouse 
pointer on the Fill handle and drag to reach the 
ending day or month.

Series, value 3-13
Key two values in the series. Select both cells and 
drag the Fill handle to reach the ending value.

Shading 4-25
Select the cell or the range. Click the arrow next 
to the Fill Color button . Choose the color.

Sort a list 10-20
Select the rows to be sorted. Click the Sort 
Ascending button .
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Spelling 3-4
Click in the worksheet and click the Spelling 
button . Choose a suggested correction and 
click Change or ignore the error.

Style, apply 6-6
Select the cell(s). Choose Format, Style. Choose 
the style name and click OK.

Style, remove 6-7
Select the cell(s). Choose Format, Style. Choose 
Normal and click OK.

Tab color 2-12
Right-click the worksheet tab and choose Tab 
Color. Choose a color and click OK.

Text box, create 9-2
Click the Text Box button  and draw the 
object on the worksheet. Key the text. Click 
another cell to deselect the box.

Texture fi ll 8-21
Right-click a bar or column. Chooses Format 
Data Series. Click the Patterns tab. Click Fill 
Effects. Click the Texture tab. Choose a texture 
and click OK.

Titles, print 6-10
Choose File, Page Setup. Click in the Rows to 
repeat at top box and select the cells. Click in 
the Columns to repeat at left box and select the 
cells. Click OK.

Undo 1-13
Click the Undo button . Click the history 
arrow next to the button and highlight the 
tasks to undo more than one action.

Ungroup worksheets 10-2
Click any tab not in the group or right-click a 
tab and choose Ungroup Worksheets.

UPPER function 7-12
Edit the cell. Position the pointer after the = 
sign and key upper(. Key the text if necessary 
with quotation marks. Press e .

Vertical alignment 4-18
Select the cell or the range. Press Ç +1 . 
Click the Alignment tab. Click the Vertical 
arrow and choose a setting. Click OK.

Web page preview 9-24
From the File menu, choose Web Page Pre-
view. Close the browser window.

Web page, save 9-23
From the File menu, choose Save as Web 
Page. Click the button to save the Entire Work-
book or the Selection: Sheet. Click Change 
Title and key the title for the browser window. 
Click OK and then click Save.

WordArt, insert 9-13
Click the WordArt button . Choose the style 
and click OK. Key the text and set the font size. 
Click OK.

Wrap text 4-19
Select the cell or the range and press Ç +1 . 
Click the Alignment tab. Check Wrap text. 
Click OK.

Zoom size 1-6
Click the down arrow next to the Zoom 
button . Choose or key the magnifi cation 
percentage.


